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1. Introduction

1.1 About This Guide
This guide is designed for end users, sales representatives, managers, and administrators who use 360

SmartDocs on a daily basis. It provides step-by-step instructions for every feature of the application, from template

management to bulk document generation and email delivery.

For installation and initial setup instructions, please refer to the 360 SmartDocs Installation & Setup Guide.

Related Documentation:

• 360 SmartDocs Installation & Setup Guide — Step-by-step instructions for installing the package, configuring

OAuth, assigning permissions, and creating buttons.

• 360 SmartDocs Word Add-In User Guide — Detailed instructions for building templates in Microsoft Word,

including fields, conditions, views, images, and tag syntax.

Tip: New to 360 SmartDocs? Start with the End-to-End Example (Section 8) for a quick walkthrough of the complete
document generation process from template design to final output.

1.2 Navigating the 360 SmartDocs App
360 SmartDocs is a Salesforce Lightning app accessible from the App Launcher. To open the app:

1 Click the App Launcher icon (the 9-dot grid) in the top-left corner of the Salesforce navigation bar.

2 Type "360 SmartDocs" in the search bar.

3 Click on "360 SmartDocs" to open the application.

Once open, you will see six tabs in the navigation bar:

Tab Purpose Who Uses It

Home Contains 360 SmartDocs Dashboard (document generation
activity, recent generations, status summaries) and 360
FileSync Dashboard (file sync activity, storage usage)

All users

Getting Started Interactive setup guide and onboarding wizard with step-by-step
instructions

Admins (initial setup)

360 SmartDocs Setup Configuration hub for license sync, permission sets, object
configuration, button management, and File Sync Setup

Admins

Templates View, create, and manage document templates Admins, template
designers
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Bulk Document
Generation

Generate documents for multiple records at once using reports
or list views

All users

360 Document
Manager

View all generated document records and their statuses All users
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2. App Navigation

2.1 Home Tab
The Home tab is the default landing page when you open the 360 SmartDocs app. It provides two key dashboards in

a single view:

• 360 SmartDocs Dashboard — Displays an overview of document generation activity, recent document

generations, status summaries, and key metrics for your org.

• 360 FileSync Dashboard — Displays file synchronization activity, sync status across connected cloud storage

providers, and storage usage metrics.

2.2 Getting Started Tab
The Getting Started tab provides a comprehensive, interactive setup guide to help administrators configure 360

SmartDocs step by step. It features a left sidebar menu with expandable sections and a main content panel on the

right.

The "Introduction – Before You Begin" section contains the following two tabs:

1. SmartDocs Setup

• Welcome — Product overview and quick-start checklist

• Step 1: Assign Required Permissions

• Step 2: Set Up the External Client App

• Step 3: Configure Application Settings

• Step 4: Upload Your Templates

• Step 5: Install and Use the Microsoft Word Add-In

• Step 6: Generate Your First Document

• Step 7: Manage Templates & Versions

• Step 8: Advanced Configurations

• Step 9: Troubleshooting & Support

• Automation & Integrations — Advanced topics for power users

2. File Sync Setup

• Welcome — Product overview and quick-start checklist

• Step 1: Assign Permission Set

• Step 2: Initialize the Application (360 SmartDocs App)

• Step 3: Select Default (Primary) Storage

• Step 4: Storage Setup and Integration

• Step 5: Object Setup

• Step 6: File Sync Component Configuration

• Step 7: Upload and Sync Your First File

• Step 8: Automatic File Deletion After Sync

• Step 9: Advanced Configurations

• Step 10: Support & Troubleshooting

• Automation & Integrations — Advanced topics for power users
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Use the Back and Next buttons at the bottom to navigate sequentially, or click any section in the sidebar to jump

directly to it.

Getting Started tab showing the Welcome panel with the quick-start checklist and SmartDocs Setup sidebar navigation.

2.3 360 SmartDocs Setup Tab
The 360 SmartDocs Setup tab is the central configuration hub for administrators. The SmartDocs Setup tab

contains the following three sub-tabs:

• License Manager — Activate and sync your SmartDocs license, view license status, SmartDocs credits, and

FileSync credits details

• SmartDocs Setup — Sidebar navigation with: Permission Set Assignment; Configuration (Step 1: Salesforce

Object Support; Step 2: Manage Buttons)

• File Sync Setup — Used to configure and manage file sync settings.

360 SmartDocs Setup tab showing the License Manager panel with license status, SmartDocs credits, and FileSync credits.
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2.4 Templates Tab
The Templates tab displays a list view of all Template records in your org. From here, you can:

• View all templates with their names, associated objects, document types, and active status

• Click on a template to open its detail page

• Click "New" to create a new template

• Use list view filters to find specific templates

Note for Admins — Template Visibility: End users with the X360_SmartDocs_User permission set do not have
"View All" access on Template__c. They will only see templates that have been shared with them via Sharing Rules.
As an admin, you must configure Sharing Rules on the Template__c object to grant read access to the appropriate
user groups. Without this step, end users will see an empty template list when generating documents.

Templates list view showing template records with Name, SObject, Document Type, IsActive status, and Last Modified columns.

2.5 Bulk Document Generation Tab
The Bulk Document Generation tab opens a multi-step wizard for generating documents for multiple records at

once. The wizard guides users through selecting a data source, choosing records, picking a template, and generating

documents in bulk.
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Bulk Document Generation wizard showing the 4-step progress path.

2.6 360 Document Manager Tab
The 360 Document Manager tab shows a list view of all X360_Document_Manager__c records — each

representing a generated document or a document generation request. You can:

• View the status of all document generations (Completed, In Progress, Failed, etc.)

• Click on a record to see its details, including the parent record, template used, and the generated file

• Use list view filters to find specific document records

360 Document Manager list view showing document records with color-coded status badges.
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3. Template Management

Templates are the foundation of 360 SmartDocs. A template is a Microsoft Word (.docx) file containing dynamic

merge fields (tokens) that are replaced with actual Salesforce data when a document is generated.

Important: Templates must be created and edited in Microsoft Word using the 360 SmartDocs Word Add-In (see
Section 4). Do not attempt to create templates with merge fields directly within Salesforce — this will result in
incorrect template structure, missing merge fields, or unusable documents. For detailed guidance on template
design, refer to the 360 SmartDocs Word Add-In User Guide.

3.1 Viewing Templates

1 Navigate to the Templates tab in the 360 SmartDocs app.

2 The list view displays all templates: Template Name, SObject Name, Document Type, IsActive status.

3 Click on any Template Name to open the template's record detail page.

4
On the detail page you can see: all template fields and settings, the Preview Attached Files component

showing uploaded file versions, and related lists for Document Manager records.

Template record detail page showing fields, the Preview Attached Files component with file versions, and the document preview panel.

3.2 Creating a New Template

1 Navigate to the Templates tab.

2 Click the "New" button at the top-right of the list view.
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3 The New Template dialog appears. Click on "Create New Template" to proceed.

4

Fill in the following fields: Template Name (required); SObject Name (required); Document Type —

Doc, Docx, Pdf, or Any; Document Name — naming pattern (e.g., "SOW - {Account.Name}"); Record
Type — Main Template or Sub Template.

5 Click "Save" to create the template record.

Tip: Use clear naming conventions for templates, such as "SOW — Implementation — Standard" or "MSA — Global
— v1.0". This helps users quickly find the right template during document generation.

Template creation form with Template Name, SObject Name, Document Type, Document Name, and Record Type fields.

3.3 Uploading Template Files
After creating a template record, you need to upload the actual Word document (.docx) file that serves as the

template.

Note: Template files must be in .docx format (Microsoft Word). Other file formats (PDF, DOC, etc.) are not supported
as template source files.

1 Open the template record you just created.

2 In the Files related list or the file upload area, click "Upload Files".
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3 Select a .docx file from your computer containing merge field tokens.

4 The file is uploaded as a ContentVersion and linked to the template record.

5 After uploading, the file appears in the Preview Attached Files component.

3.4 Activating and Deactivating Templates
Only active templates appear in the template selection dropdown during document generation.

Using the Preview Attached Files Component (Recommended)

1 Open the template record page.

2
In the Preview Attached Files component, select the file version you want to activate by clicking on its

card in the left panel.

3 Click the "Activate Template" button in the right panel header.

4 The file card will now display an "Active Template" badge.

Note: You can also activate/deactivate a template by editing the Template record directly and setting the "IsActive"
checkbox. If activating directly, you must also populate the "Active_Version_Id__c" field with the ContentDocument
ID. The recommended approach is to use the Preview Attached Files component, which handles this automatically.

Preview Attached Files showing the "Activate Template" button. The "Activate Template" button will not be visible for already activated
version.
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Warning: Deactivating a template will immediately prevent users from selecting it during document generation.
Ensure no active workflows depend on the template before deactivating.

3.5 Using the Preview Attached Files Component
The Preview Attached Files component is a two-panel interface available on every template record page:

Left Panel — File List

• Displays all uploaded file versions as clickable cards

• Each card shows: file icon, file title, version number, last modified date, file size

• Active version displays a green "Active Template" badge

• Click a card to select it and see its preview in the right panel

Right Panel — Preview & Actions

• Header: Shows the selected file name and version info

• Edit Template — Opens the template in the Word Add-In for editing

• Activate Template — Sets the selected version as the active template

• Preview Area: Shows a rendered preview of the document in an iframe

• Refresh button in the top-right corner to reload the file list

Full Preview Attached Files component with file cards in the left panel and a document preview in the right panel.
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4. Microsoft Word Add-In

Detailed Guide Available: This section provides a quick overview of the Word Add-In. For comprehensive
instructions on building templates — including conditions, views, images, formatting options, and tag syntax — see
the 360 SmartDocs Word Add-In User Guide.

The 360 SmartDocs Word Add-In allows you to design and edit document templates visually in Microsoft Word. It

provides a sidebar within Word for browsing Salesforce objects and fields, inserting merge tokens, previewing

documents, and saving templates directly back to Salesforce.

• Create — Design your template by inserting merge fields and formatting the document layout

• Preview — Preview the document with actual Salesforce data to verify the output before publishing

• Live — Save and activate the template in Salesforce, making it available for document generation

4.1 Installing the Add-In

1 Open Microsoft Word (desktop version — Microsoft 365 or Office 2019 or later).

2 Click the "Insert" tab in the Word ribbon.

3 Click "Get Add-ins" (or "Office Add-ins").

4 In the Office Add-ins dialog, switch to the "Store" tab.

5 Search for "360 SmartDocs".

6 Click "Add" next to the 360 SmartDocs Add-In.

7 The Add-In installs and appears in the Word ribbon.
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Microsoft Word ribbon with the "Insert" tab active and the "Get Add-ins" button highlighted.

4.2 Connecting to Salesforce

1 Click the 360 SmartDocs icon in the Word ribbon to open the Add-In sidebar.

2
The sidebar displays a login screen. Click the Salesforce environment (Production or Sandbox) you

want to connect to.

3 A Salesforce login popup appears. Enter your Salesforce username and password.

4 If prompted, approve the OAuth authorization request.

5 Once connected, the sidebar shows a success message and loads the template management interface.
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Word Add-In sidebar showing the login screen with the Sign in to Production and Sign in to Sandbox buttons.

Note: The Add-In requires the External Client App / OAuth configuration to be completed by your administrator. If
you see a connection error, contact your Salesforce admin to verify the OAuth setup.

4.3 Inserting Merge Fields / Tokens
Merge fields (tokens) are placeholders in your Word template that get replaced with actual Salesforce data during

document generation.

1 With the Add-In sidebar open and connected to Salesforce, you will see a field browser panel.

2 Select the Salesforce object your template is associated with (e.g., Opportunity).

3 Browse or search through the object's fields and related objects in the tree view.

4 Click on a field to select it. The merge token syntax will be shown (e.g., {Name}, {Account.Name}).

5 Click "Insert" to insert the token at the current cursor position in your Word document.

6
The token appears in the document as a placeholder text that will be replaced with real data during

generation.

7 Repeat for all fields you want to include in the template.
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Word Add-In field browser showing the Opportunity object tree with fields and related objects.

Word document with merge field tokens inserted. Tokens will be replaced with Salesforce data.

Tip: You can also type merge tokens manually using the {FieldName} or {RelationshipName.ParentFieldName}
syntax. However, using the Add-In's field browser helps prevent typos and ensures you use valid field API names.

4.4 Previewing the Document
Before saving your template to Salesforce, you can preview the document to see how it will look with actual

Salesforce data merged in.

1 After inserting your merge fields, click the "Continue to Preview" button in the Add-In sidebar.
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2
The Add-In fetches sample data from Salesforce and generates a preview of the document with merge

tokens replaced by real field values.

3 Review the previewed document to check formatting, spacing, and data placement.

4
If adjustments are needed, go back to the CREATE tab in the Add-In sidebar, make your changes, and

preview again.

5 Once satisfied, click the "Continue to Publish" to save the template in Salesforce.

Word Add-In preview step showing the document being prepared for preview with Salesforce data.

Document preview result showing the template rendered with actual Salesforce data, with merge tokens replaced by field values.
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Tip: Always preview your template before saving to Salesforce. This ensures that merge fields resolve correctly and
the final document layout matches your expectations.

4.5 Saving Templates Back to Salesforce

1 After designing your template in Word, click the "Continue to Publish" button in the Add-In sidebar.

2 Fill out all the details related to the template.

3 Once ready, click "Publish Template" button.

4 The file is uploaded to Salesforce as a new ContentVersion linked to the template record.

5
Return to Salesforce and open the template record to verify the new version appears in the Preview

Attached Files component.

6 If needed, click "Activate Template" to make this new version the active one.

Word Add-In "Save to Salesforce" panel with template selector, version information, and Save button.
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5. Single Document Generation

Single document generation creates a document from one Salesforce record using a selected template. There are

two ways to trigger it: via a Quick Action or via a URL Button.

When to Use Single Document Generation:

• Generating a proposal or SOW for a specific Opportunity during a sales meeting

• Creating a contract or agreement for a single Account that is ready for signing

• Producing an invoice or quote for one customer order

• Generating a personalized welcome letter for a new Contact

5.1 Generating via Quick Action

1
Navigate to a Salesforce record page (e.g., an Opportunity record) that has the SmartDocs Quick Action

configured.

2
In the record's highlight panel (the actions area at the top of the record), look for the "Create
Document" action button.

3 Click the action button. The Document Generation Wizard opens as a modal dialog.

4 Follow the wizard steps (described in Section 5.3 below).

Salesforce record page showing the "Create Document" Quick Action button in the record's actions area.
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5.2 Generating via URL Button

1
Navigate to a Salesforce record page that has a SmartDocs URL Button configured (e.g., "Generate

SOW (PDF)").

2 Click the URL button on the record detail page.

3
The browser navigates to the SmartDocs component page. If Execution Mode=auto: generation starts

immediately. If Execution Mode=view: the wizard opens for user interaction.

5.3 The Document Generation Wizard
The Document Generation Wizard guides you through the document creation process with a visual progress path
showing each step.

Document Generation Wizard progress indicator showing two steps: Select Template, and Send Email.

5.3.1 Step 1: Select Template

1
The "Available Templates" dropdown shows all active templates mapped to the current object. Select a

template from the dropdown.

2 Once a template is selected, its description appears below the dropdown for reference.

3 Choose the "Document Type": Doc (generates a .docx file) or Pdf (generates a PDF file).

4
If triggered via Quick Action, you will see a toggle: "Send email with generated document". Enable this

to email the document after generation.

5 Click "Next" to proceed to the next step.
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Salesforce record page showing a SmartDocs URL button on the record detail page.

Wizard Step 1: "SOW - Standard Implementation" selected, Document Type set to "Pdf", and email toggle enabled.

Note — Field Access Validation: After template selection, the system checks whether you have read access to all
fields used in the template. If any fields are inaccessible, a Field Access Warning screen is displayed. See Section
6.8 — Field Access Validation for full details.

5.3.2 Step 2: Send Email (Optional)

If email sending was enabled, the Email Composer appears after document creation. The Email Composer allows

you to configure From, To, CC, BCC, Subject, Body, and email templates before sending the generated document as

an attachment.
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Wizard Email step with the Email Composer showing From, To, Subject, Body, and the generated document automatically attached.

5.4 Processing and Status Tracking
After clicking "Generate Document", the wizard transitions to a processing screen:

• An animated progress indicator shows that document generation is in progress

• A status message updates as the process moves through stages

• Once complete, it will redirect you to the record detail page with a success message.

• The generated document will be attached to the record under the related files section.

• If the generation fails, an error message is displayed with details about what went wrong

Document processing screen showing a spinner and progress bar with the "Generating document..." status message.
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6. Bulk Document Generation

Bulk Document Generation allows you to create documents for multiple records at once, using data from a

Salesforce Report or a List View.

When to Use Bulk Document Generation:

• Monthly invoicing — Generate invoices for all customers with outstanding balances at month-end

• Batch contract generation — Create renewal contracts for all Opportunities closing this quarter

• Mail merge campaigns — Produce personalized letters or proposals for a targeted list of Accounts or Contacts

• Compliance documents — Generate standardized compliance or audit documents for all records matching specific
criteria

6.1 Accessing Bulk Document Generation

1 In the 360 SmartDocs app, click the "Bulk Document Generation" tab in the navigation bar.

2 The Bulk Document Generation wizard opens with a progress path showing the steps you will follow.

6.2 Step 1: Select Data Source
Choose where the records for bulk generation will come from:

• Report — Use records from a Salesforce report

• List View — Use records from a specific object's list view

If you selected "List View": Select the Object from the object dropdown (e.g., Opportunity), then select a List View for

that object.

If you selected "Report": A Search Reports field appears. Type to search for a report by name, then select a report

from the dropdown.

Note: Report Requirements

• Report should be tabular.

• First column of report should be Id.

• If you want to generate documents from report, you must follow these basic steps:

1. Create a custom field — Data Type: Auto Number | Field Label: Filter Number | Display Format: {000000} |
Starting Number: 1 | Generate Auto Number for existing records: True | Field Name: Filter_Number

2. Use this field as a filter criteria: Filter Number greater than 0.

3. Add this field to the report column and sort it by Ascending.

1 Click "Next" to proceed to record selection.
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Bulk wizard Step 1 with "Report" source type selected, showing report requirements and setup steps.

6.3 Step 2: Select Records
Review the loaded records and select which ones should have documents generated:

1 A data table displays all records from your selected data source, with checkboxes on each row.

2 Use the Select All / Deselect All buttons above the table to quickly select or deselect all records.

3 Individually check or uncheck records as needed.

4 The record count summary above the table shows "Total: X | Selected: Y".

5 If there are many records, scroll down and use "Load More" to load additional pages.

6 Click "Next" when your selection is ready.
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Bulk wizard Step 2 showing a data table with checkboxes for record selection. The count summary shows 45 of 150 records selected.

6.4 Step 3: Select Template
Choose the template and document type for bulk generation:

• Left panel (Template Settings): Template dropdown and document type selector

• Right panel (Template Preview): Live preview of the selected template in an iframe

1
Select a template from the "Available Templates" dropdown. Only templates mapped to the selected

object and marked as active will appear.

2 Select the Document Type: Doc (DOCX) or Pdf (PDF).

3 The right panel updates to show a preview of the selected template.

4 Review the template preview to confirm it is the correct one.

5 Click "Next" to proceed to review.

Bulk wizard Step 3 with split layout: "Invoice - Monthly" template selected on the left, template preview on the right.

Note — Field Access Validation: After template selection, the system checks whether you have read access to all
fields used in the template. If any fields are inaccessible, a Field Access Warning screen is displayed. See Section
6.8 — Field Access Validation for full details.

6.5 Step 4: Review & Generate
Confirm your selections before starting bulk generation:

• Source Type: Report or List View

• Source: The name of the report or list view selected

• Template: The template name
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• Document Type: Doc or Pdf

• Records: Total number of records selected for generation

1 If everything looks correct, click the "Generate" button to start bulk document generation.

2 If you need to make changes, use the "Back" button to return to previous steps.

Bulk wizard Step 4 showing the generation summary: List View source, SOW template, Pdf type, 45 records selected.

6.6 Status Tracking and Progress
After clicking "Generate", the wizard transitions to a status tracking view:

• A progress bar shows the overall completion percentage

• A status table shows each record's individual status: Completed, Processing, Pending, or Failed

• Message — Success confirmation or error details

• Actions — Links to view the parent record or the Document Manager record

Bulk generation status tracking with progress bar and per-record status table showing Completed, Processing, and Pending statuses.

Note: For large batches (100+ records), generation runs as a background batch job in Salesforce. You can safely
navigate away from the page — the generation will continue in the background and you will receive an email when it
completes.
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Note: The Status Tracking progress view is not visible in the case of Report source type or when using List View with
"Select All" option. In these cases, generation runs entirely in the background and you will be notified by email upon
completion.

6.7 Using List View Buttons
If your administrator has set up a List View Button for an object, you can also trigger bulk generation directly from

the object's list view:

1 Navigate to the object's list view (e.g., Opportunities → All Opportunities).

2 Select records using the checkboxes in the leftmost column of the list view.

3 Click the Bulk Generate Documents button (or equivalent name) in the list view toolbar.

4
1–199 records: Generation starts immediately. 200 records: You are given a choice: "Process selected

200 records only" or "Process all records in this list view".

Salesforce Opportunities list view with records selected and the "Generate Proposals in Bulk" button in the toolbar.

6.8 Field Access Validation
Whenever a template is selected for document generation, the system automatically performs a Field-Level Security
(FLS) check. It inspects all fields referenced in the template's queries and verifies that the current user has read
permission on each field.

If one or more fields are not accessible, a Field Access Warning screen is displayed. The warning screen includes:

• A warning banner explaining that the selected template references fields the user does not have permission to

read

• A table listing every inaccessible field with: Query Type, Object, and Field API name

• "Cancel" — Stops the generation process and returns the user to the previous step
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• "Continue Anyway" — Proceeds with document generation. Inaccessible fields will appear blank in the

generated documents

Field Access Warning screen displaying inaccessible fields detected in the selected template, with options to Cancel or Continue Anyway.

Warning: If you choose "Continue Anyway", any inaccessible fields will render as blank values in the generated
documents. To ensure all fields populate correctly, ask your Salesforce administrator to grant read access to the
required fields via Permission Sets or Profiles.
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7. Custom Related List Component

The Custom Related List component displays document generation history (or any related records) directly on a

Salesforce record page. It provides a rich data table with sorting, infinite scrolling, and navigation capabilities.

7.1 Adding to Record Pages

1 Navigate to the record page where you want to add the related list (e.g., an Opportunity record page).

2 Click the gear icon → "Edit Page" to open the Lightning App Builder.

3
In the Components panel on the left, search for "customRelatedListComponent" (it appears under

Custom components).

4
Drag the component into the desired position on the page layout (typically in the Related section or a

sidebar).

5 Configure the component properties in the right-side panel (see Section 7.2).

6 Click "Save" and then "Activate" the page.

Custom Related List component showing "Related Documents" with 14 generated document records, Status and Document Type columns.
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7.2 Configuration Properties
After placing the component on the page, configure the following properties:

Property Description Example Value

iconName SLDS icon for the component header standard:document

pNoteObjectApiName API name of the child object to display x360SmartDocs__X360_Document_
Manager__c

pRelatedListTitle Display title for the related list header Generated Documents

pLookupField The lookup/reference field on the child object that
points to the parent record

x360SmartDocs__Parent_Record_Id
__c

pLinkField The field to make clickable for navigation Name

pNotesFields Comma-separated list of field API names to
display as columns

Name,x360SmartDocs__Document_
Type__c,x360SmartDocs__Status__
c

showNewButton Whether to show a "New" button false

pDefaultSortedBy Default sort field CreatedDate

pDefaultSortDirection Default sort direction desc

pPageSize Records per page (1-200) 50
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8. End-to-End Example: Generating a Document from an
Opportunity

This section walks through the complete workflow from start to finish, using an Opportunity record as an example.

Prerequisites: Before starting, ensure that 360 SmartDocs is installed and configured (see the Installation Guide),
and that your user account has the appropriate permission set assigned.

Step 1: Design the Template in Microsoft Word

1 Open Microsoft Word and launch the 360 SmartDocs Add-In from the ribbon.

2 Log in to your Salesforce org and click the New button.

3 Design your document layout — add headers, company logo, tables, and formatting as needed.

4
Use the Add-In's field browser to insert merge fields (e.g., {Name}, {Account.Name}, {Amount},

{CloseDate}).

5 Switch to the Preview tab in the Add-In to verify the document renders correctly with real Salesforce data.

6
When satisfied, go to the Live tab, fill all the required fields and click "Publish Template" to upload the

template in Salesforce.

Step 2: Generate a Document from an Opportunity Record

1 Navigate to an Opportunity record in Salesforce.

2 Click the "Create Document" Quick Action button (or the URL button your admin configured).

3
In the Document Generation Wizard: Select the template you created; Confirm the Document Type (e.g.,

Pdf); Optionally enable "Send email with generated document".

4 Click "Next" and follow through to generate the document.

Step 3: Review the Generated Document

1 After generation completes, you will be redirected back to the Opportunity record.
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2 The generated document will appear in the Files related list on the record.

3
You can also find the document in the 360 Document Manager tab, where it will show a "Completed"

status.

Tip: Use this same workflow for any object (Account, Quote, Case, custom objects, etc.). The only differences are
the template's SObject Name and the merge fields you insert in the Word template.
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9. 360 Document Manager Records

9.1 Understanding Document Manager Records
Every document generation — whether single, bulk, or automated — creates an X360_Document_Manager__c
record. This record tracks the generation process, stores references to the template and generated file, and provides

a complete audit trail.

The record name follows an auto-number pattern: DocGen-00001, DocGen-00002, etc.

9.2 Key Fields Reference

Field Description

Name Auto-generated record name (e.g., DocGen-00042)

Template Lookup reference to the Template record used for generation

Template Version Id The specific template file version used at the time of generation

Document Type The output format: Doc (DOCX) or Pdf (PDF)

Status Draft / In Progress / Merging / Finalizing / Completed / Failed

Parent Record Id The Salesforce record ID of the parent record (e.g., the Opportunity this document was
generated from)

Parent Object Name The API name of the parent object (e.g., Opportunity, Account)

Document Version Id The ContentVersion ID of the generated output file

Created From "Detail Page Button", "List View", "Report", "Flow/Apex"

Batch Job Id For bulk generations, the Salesforce batch job ID (useful for tracking and
troubleshooting)

Transaction Id Unique request identifier for tracing through logs

9.3 Viewing Generated Documents

1
Open a Document Manager record (from the 360 Document Manager tab, a related list, or a notification

link).

2 The record detail page shows all fields described above.

3
The generated document file is attached to the record via Files. Look for the file in the Files related list or

Notes & Attachments section.

4 Click on the file name to preview it in Salesforce's built-in file viewer.
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5 Click "Download" to save the file to your computer.

6 The file is also linked to the parent record (e.g., the Opportunity).

Document Manager record detail showing DocGen-01679 with Completed status, template reference, parent record link, and the generated
document file.
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10. Error Logs

10.1 Accessing Error Logs
Error logs provide detailed information about any failures that occur during document generation, template

processing, or system operations.

1
In the 360 SmartDocs app, you may find an Error Logs tab (if configured by your admin) or navigate to

the Error Log object via the App Launcher.

2 The list view shows all error records, sorted by most recent first.

3 Click on an error record to see full details.

Error Log record detail (ERR-00176) showing error message, error type, class name, method name, severity, and user information.

10.2 Understanding Error Log Fields

Field Description

Error Type The category of error (e.g., DmlException, HttpException, ValidationException)

Error Message A human-readable description of what went wrong

Severity How critical the error is: Low, Medium, High, or Critical

Class Name The Apex class where the error originated

Method Name The specific method that encountered the error

Stack Trace The full technical stack trace (useful for developer troubleshooting)

Record Id The Salesforce record associated with the error (if applicable)

Object Name The Salesforce object involved
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User The user whose action triggered the error

Transaction Id Unique identifier for correlating errors across batch operations

Batch Job Id The batch job ID if the error occurred during bulk generation

10.3 Common Errors and Resolutions

Error Likely Cause Resolution

"Insufficient privileges" or
CRUD/FLS error

User lacks required permissions
on an object or field

Verify the user has the correct permission set
(X360_SmartDocs_Admin or
X360_SmartDocs_User) assigned. Check field-level
security for any custom fields.

"Package is not active" error The SmartDocs license is
inactive or expired

Navigate to SmartDocs Setup → License Details
and click "Sync" to refresh the license status.

HTTP callout error / Server
unreachable

The document generation server
cannot be reached

Check the Remote Site Setting for x360SmartDocs
in Salesforce Setup. Verify your network allows
outbound connections.

"Template not found" or "No
active version"

The template record is missing,
inactive, or has no active file
version

Open the template record and ensure: (1) IsActive is
checked, (2) A file version is uploaded, (3) The file
version is activated via the Preview component.

No templates visible in
wizard (empty template list)

End user does not have visibility
to Template__c records —
Sharing Rules not configured

Create Sharing Rules on Template__c in Salesforce
Setup → Sharing Settings to grant read access to
end users.

Batch job failure with partial
completion

A batch chunk encountered an
error

Check the Document Manager records for "Failed"
status. Review the Error Log for the batch job ID.
Re-generate only the failed records.

Merge field not resolved
(shows raw token in output)

The merge field references a
field that doesn't exist or the user
lacks access

Verify the merge field syntax matches the object and
field API names. Ensure the user has read access
to the referenced fields.
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11. Creating Buttons on Any Object

This section provides complete instructions for creating SmartDocs buttons on any Salesforce object. Three types of

buttons are supported, each suited for different use cases.

11.1 URL Button Setup

1 Go to 360 SmartDocs App → 360 SmartDocs Setup Tab → SmartDocs Setup.

2 Click "Step 2: Manage Buttons" in the left sidebar.

3 Click "New Button".

4
Enter the required button details, including: Button Label, Object Name, and additional configuration

fields.

5 From the Button Type dropdown, select URL Button (Detail Page).

6 Click Deploy to deploy the button immediately. Alternatively, click Save Draft.

Sub-step: Add to Layout

1 Go to Setup → Object Manager → select your object.

2 Open the page layout editor.

3 Click "Buttons" in the palette.

4 Drag your new action into the "Custom Buttons" section.

5 Click "Save".

11.2 Quick Action Setup

1 Go to 360 SmartDocs App → 360 SmartDocs Setup Tab → SmartDocs Setup.

2 Click "Step 2: Manage Buttons" in the left sidebar.
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3 Click "New Button".

4 Enter the required button details, including: Button Label and Object Name.

5 From the Button Type dropdown, select Quick Action (Detail Page).

6 Click Deploy to deploy the button immediately. Alternatively, click Save Draft.

Sub-step: Add to Layout

1 Go to Setup → Object Manager → select your object.

2 Open the page layout editor.

3 Click "Mobile & Lightning Actions" in the palette.

4 Drag your new action into the "Salesforce Mobile and Lightning Experience Actions" section.

5 Click "Save".

11.3 List View Button Setup

1 Go to 360 SmartDocs App → 360 SmartDocs Setup Tab → SmartDocs Setup.

2 Click "Step 2: Manage Buttons" in the left sidebar.

3 Click "New Button".

4 Enter the required button details, including: Button Label and Object Name.

5 From the Button Type dropdown, select List View Button (Bulk).

6 Click Deploy to deploy the button immediately. Alternatively, click Save Draft.

Sub-step: Add to Search Layouts

1 Go to Setup → Object Manager → select your object.
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2
In the object's Object Manager page, click "Search Layouts for Salesforce Classic" or "List View
Button Layout".

3 Edit the List View layout and add your button to the "Selected Buttons" list.

4 Click "Save".
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12. Flow and Apex Integration

360 SmartDocs provides an Invocable Action that can be called from Salesforce Flows, Process Builder, or Apex

code. This enables automated document generation as part of your business processes.

When to Use Flow/Apex Integration:

• Auto-generate welcome letters when new Accounts or Contacts are created

• Trigger contract generation automatically when an Opportunity stage changes to "Closed Won"

• Generate approval documents as part of an approval process flow

• Schedule recurring document generation via scheduled flows (e.g., weekly status reports)

12.1 Using the Invocable Action in Flow

1 Open Salesforce Flow Builder (Setup → Flows → New Flow).

2 Add an Action element to your flow.

3 Search for "Create Document Manager" (or "createDocumentManagers") in the action search.

4 Select the 360 SmartDocs - Create Document Managers invocable action.

5 Configure the input parameters (see Section 12.2 below).

6 Optionally, capture the output parameters to track the result.

7 Connect the action element to the rest of your flow logic.

8 Save and activate the flow.

12.2 Input / Output Parameters

Input Parameters

Parameter Required Type Description

templateId Yes Id (Text) The record ID of the Template__c record to use for document
generation

parentRecordId Yes Id (Text) The record ID of the parent Salesforce record

Contact - US: +1 323 641 4417 | UK: +44 740 327 9473 | AUS: +61 48885 3632 | IN: +91 852 710 0131 



360 SmartDocs Feature & User Guide  •  Version 1.25.2

Page 41

parentObjectName Yes Text The API name of the parent object (e.g., "Opportunity",
"Account", "Custom_Object__c")

documentType Yes Text The output format: "Doc" (DOCX) or "Pdf" (PDF).

Output Parameters

Parameter Type Description

documentManagerId Id (Text) The record ID of the created X360_Document_Manager__c record

isSuccess Boolean true if the document generation was initiated successfully, false
otherwise

errorMessage Text Error details if isSuccess is false. Empty string if successful.

Tip: The invocable action supports bulk input — you can pass multiple records in a single flow loop. Each input
creates a separate Document Manager record and triggers generation independently.

Note: When triggered from Flow, the Created_From field on the Document Manager record is set to "Flow/Apex",
making it easy to distinguish automated generations from user-initiated ones in reports and list views.
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13. Introduction to 360 File Sync

The Complete Solution — 360 FileSync integrates SharePoint, AWS S3, Google Drive, OneDrive and SFTP into

Salesforce with centralized file and document management. Enabling seamless file access, reducing storage costs,

and enhancing team collaboration.

360 File Sync was built to solve the exact challenges organizations face with Salesforce storage. It's more than a

storage tool — it's a comprehensive file management ecosystem that helps you regain control of your documents

without compromising on cost, speed, or structure.

14. Setting Up Drive Sync

Follow these steps to sync your Drive with Salesforce:

1
Open the 360 SmartDocs App — Navigate to the App Launcher in Salesforce. Search for and open

“360 SmartDocs”.

2

Connect Your Cloud Drive — Choose your drive provider (e.g., Google Drive, OneDrive). Authenticate

by logging into your drive account. Grant necessary permissions when prompted. Once you click on

continue, you will be navigated back to your Salesforce org. The Drive is now connected and it will reflect

in your org.
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15. Setting Up an Object for Sync

Follow these steps to configure a Salesforce object for file synchronization with your cloud drive:

1 Open Object Setup — Within the File Sync Setup, navigate to “Object Setup”.

2
Add New Object — Click “New”. Select the Salesforce Object you want to sync files with (e.g., Account,

Opportunity, Lead). Click on “Next.”

Object Setup — Select the Salesforce Object you want to sync files with.

3
Map Object Fields — Map key fields: Primary Key Field (e.g., Record ID or Name), Folder Naming

Convention (optional but recommended), and select your Sync Preferences. Click on “Next.”

Object Setup — Map Object Fields and configure Folder Naming Convention.

4

Sync Setup — Configure your syncing preferences: Sync Records — Toggle to initiate the syncing

process for existing records. Custom Range — Sync All Records or select a specific date range. Delete
Synced Files — If enabled, the following file types will automatically be deleted from Salesforce once

synced: Attachments (classic Salesforce Attachments), Notes and Attachments, and Files (Salesforce

Files / ContentDocument). Only the records synced in the current operation will be deleted.
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Sync Setup — Configure sync records, custom date range, and delete options.

Caution: Deleting files that are synced to your cloud storage from Salesforce may disrupt other Salesforce features
or functions that rely on these files. Proceed with caution and ensure you understand the impact.

5

Save Configuration — Check to see if the created object setup details are as per your preference. Click

Save once the object and mapping are configured. The system will automatically create folders in your

drive based on this setup.

Object Setup — Synced files are now visible in the related section of the Salesforce record.

Tip: After completing the setup, you will be able to see your synced files in your Salesforce org in the related section
of the record.

360 SmartDocs — Feature & User Guide • Version 1.25.2

16. Salesforce and Its Storage Challenges

Salesforce is a leading CRM platform utilized globally by businesses to manage customer relationships, streamline

sales processes, and enhance productivity. Despite its powerful capabilities, Salesforce faces significant limitations in

file storage management. Businesses often struggle with limited and costly storage, inefficient synchronization of
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files, and complex file management procedures. These limitations frequently result in scattered document storage,

increased costs, reduced productivity, and diminished collaboration capabilities.

16.1 Understanding Salesforce Storage Challenges
Salesforce categorizes storage into Data Storage, File Storage, and Big Objects, each serving distinct purposes.

However, organizations quickly encounter storage constraints as their data and file requirements grow:

• Limited and Expensive File Storage: Salesforce provides limited file storage space, and exceeding these

limits incurs substantial additional monthly fees, impacting operational budgets significantly.

• Inefficient File Management: Without a centralized approach, files scattered across multiple external drives

complicate accessibility and document retrieval.

• Complex and Time-consuming Syncing: Manual file synchronization processes lead to data inconsistencies

and increased workloads, reducing overall productivity.

• Performance Issues: Excessive files stored within Salesforce slow down the CRM, negatively affecting

performance and user experience.
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